
Stereolusions Help Contents
Stereolusions is a Microsoft Windows based program designed to create Single Image Random Dot 
Stereograms (SIRDS) and Single Image Stereograms (SIS).    To use it, you must first draw a picture 
using a program such as Microsoft Paintbrush or CorelDRAW!    Then, load the picture into Stereolusions 
and render it as a Stereogram.    You can view the image on the screen or print it out.
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Creating Stereograms - Overview

Making stereograms is simple and fun.    The process involves the following steps:

1. Create a source image.    Use white as the background and black or gray for foreground objects.    
Avoid dithered colors.

2. Load the image in Stereolusions
3. If desired, resize the image by sizing the image window.
3. Select the colors and other parameters to use from the Rendering Options dialog and Pattern menu. 

If you want to use a pattern, choose Custom Pattern and select a file.
4. Render the image by selecting Render from the Image menu.
5. View and/or print the image.

Several sample source images and patterns are included for you to try.    To load a source image, select 
Open from the File menu.    A dialog box listing file names will appear.    Choose the file type from the 
selector at the bottom, then select the file to open.
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What are Stereograms

Stereograms are images which appear as a flat collection of dots or patterns.    When viewed in a 
particular manner, 3-dimensional images become apparent within the picture.    Images which are based 
on a repeating pattern, rather than random dots, are called Single Image Stereograms (as opposed to 
multi-image stereograms which consist of two separate images that must be fused).    Those composed of
random dots are called Single Image Random Dot Stereograms (SIRDS).    Today's stereograms first 
originated in the 1950's, but have their roots in the 1800's.    Recently, stereograms have become a 
popular form of art and entertainment.    

How do they work?    When you look at an image normally, both eyes focus on the same point.    When 
viewing stereograms, you shift your eyes so that each one is looking at a different part of the repeating 
pattern.    Since it is a repeating pattern, each eye sees the same thing - just a different instance of it.    By 
shifting parts of the pattern, the computer can make them seem closer up or farther away.

________
See also

Viewing Stereograms 



Creating a Source Image

Stereolusions can read images stored in the Windows Bitmap (BMP) format or the Windows Metafile 
(WMF) format.    Most paint or drawing programs, such as Microsoft Paintbrush (Included with Windows), 
CorelDRAW!, or Aldus PhotoStyler can save images in one or both of these formats.    See your MS 
Windows User's Guide for more information about Paintbrush.

Depth levels (how far an object appears to come forward or backward when seen as a 3-D image) for 
objects in Stereolusions are derived from the color of the object in the source image.    Typically, white is 
used as the background, and foreground objects are drawn in black or a shade of gray.    Depending on 
the darkness, objects will appear closer to or farther from the viewer.    

To make a stereogram, first create a drawing with Paintbrush or another drawing program and save it as a
BMP or WMF file.    Then open the file in Stereolusions and select Render from the Image menu to render
it.    You can change the colors, pattern, and other parameters of rendering with the Rendering Options 
dialog box.

_________
See also

Hints - What Works Best 



Rendering Options

Granularity
This controls the coarseness of the generated image.    The value is the size (in pixels) of the blocks that 
Stereolusions makes and shifts to create the stereograms.    Larger granularity results in faster rendering.  
Smaller granularity results in finer images, but if too small it can be difficult to see the hidden images.

Depth scaling
This controls the "3D-ness" of the image.    Large values cause more left-right shift in the stereograms.    
Values which are too large or small can make the image difficult to see.    As a general rule, try values 
which are about one-third of the interval setting.

Interval
This is the width, in pixels, of the vertical pattern band which is repeated throughout the image starting at 
the left.    The repetition interval determines how much your eyes have to shift in order to see the 3D 
image.    Values which are too large or small can make the image difficult to see.    This value should 
typically be set so that the convergence dots are 1 - 1.5 inches apart.

Defaults
Restores the above values to their defaults.    Use this if you get hopelessly messed up.



Advanced Options

Convergence dot size
Sets the radius of the "Convergence dots" which are drawn at the top of the image after rendering.

Convergence dot color
Sets the color of the "Convergence dots" which are drawn at the top of the image after rendering.    
Double-click on the colored box to change the color.

Draw convergence dots
if checked, Stereolusions will draw two "convergence dots" at the top of the stereogram after rendering.    
See Viewing Stereograms.

Beep after rendering
If checked, Stereolusions will beep when rendering a stereogram is completed.

Pattern random seed 
If this is blank or zero, when you are using random squares or circles for your pattern, the pattern will be 
different each time you render an image.    If you enter a number here, this number will be used as a seed 
to generate the random pattern.    If the seed stays the same, the pattern will stay the same each time it is 
rendered.    This is useful if you are generating animation frames.

Defaults 
Sets the above values to their defaults.



Image Menu

Render
Causes a stereogram to be generated from the image shown in the image window.    Note: an image 
which has been rendered as a stereogram cannot be rendered again.    You must first revert it to the 
original form, then render it.

Revert
Restores the image in the image window to its original contents and size.    Not available if the image was 
pasted from the clipoard.

Rendering Options...
Opens the Rendering Options dialog box.    See Rendering Options .

Advanced Options...
Opens the Advanced Options dialog box.    See Advanced Options .



File Menu

Open
Select Open from the File menu to choose the image file containing the source image you want to use.    
Stereolusions can read Window Bitmap (BMP) and Windows Metafile (WMF) files.

Save As
Select Save As and choose a file name if you want to save a stereogram you have generated for later 
viewing or printing.    Stereolusions saves images in the Windows Bitmap (BMP) format.

Print
You can print Stereograms generated by Stereolusions on almost any printer.    See Printing Images .

Filenames
The names of up to four recently opened source files are listed.    Select one of these to open the file 
again.

Exit
Exits Stereolusions.



Edit Menu

Copy
Copies the image in the image window, whether a source picture or a stereogram, onto the clipboard.    
You can then paste it in other programs.

Paste
Pastes a picture from the clipboard into Stereolusions image window.    Pictures can be copied onto the 
clipboard from other programs such as Windows Paintbrush.



Pattern Menu

Random Squares
Chooses random dots (squares) as the pattern.    The colors are determined by the Pattern Colors dialog 
box.    Selecting this option will make the stereogram a SIRDS (Single Image Random Dot Stereogram).

Random Circles
Similar to random squares, but uses circles as the pattern element.

Custom Pattern...
Lets you choose a bitmap file containing the pattern to render the stereogram in.

Pattern Colors...
Lets you choose the colors of the random dots if you are using a random pattern.

Copy X, Copy Y --- Copy X, Repeat Y
These options determine how the pattern (if you are using a custom pattern) is translated into the final 
image.    X is the horizontal axis, and Y is the vertical axis.    Copy means a direct 1 to 1 translation of the 
pattern on that axis.    Stretching means that the pattern will be enlarged or reduced along the axis to fit 
the height of the image or the repetition interval.    Repeating (Y only) causes the pattern to be repeated 
along the vertical axis if it is shorter than the final image.

See also
Using Patterns 



Using Patterns 

Stereograms are usually more interesting to look at and often easier to see if they are created with an 
interesting pattern rather than random dots.    A number of sample patterns are included with the program,
and you can use these to get started.    You can also create your own by drawing them or scanning them.  
Photographs can be a good source of interesting patterns.

When creating patterns, keep in mind the final size of the image.    A good pattern should be about the 
same width as one repetition of the stereogram - usually 1 to 1.5 inches.    It should be about the same 
height as the final image also (in pixels), unless you intend to have it repeated vertically as well as 
horizontally.    

When rendering, the granularity should be set at 1 for best results.

After loading the pattern, you should decide how you want it to be used - should it be stretched/shrunk 
along one or both directions to fit the image and repetition interval, or should it be copied?    If it is too 
short, should it be repeated along the Y axis?    Select the appropriate option from the Pattern menu, 
where X is the horizontal axis and Y is the vertical axis.    See Pattern Menu  for more information.

Different patterns work best with different images and settings.    Experiment to see what works best for 
you and your images.



Convergence dots

Convergence dots are a pair of dots at the top center of the stereogram.    You can use them as an aid in 
viewing the 3-D image.    They will be drawn on completion of rendering if "Draw convergence dots" is 
checked in the Advanced Options menu.

________
See also

Viewing Stereograms 



Hints - What Works Best

Source images
Simple pictures with shapes that are easy to recognize work well.
Black or gray objects on a white background are preferred.
Non-dithered colors or gray scales are essential.    Dithered colors will not produce good images.
Windows Metafiles (WMF's) have the advantage of being scaleable without becoming distorted or 
jagged.
Scanned photographs will NOT work well because the darkness of each part of the image is determined
by the light reflected from it in the original scene, not its distance from the viewer.

Patterns
Patterns with lots of detail and many colors work well.
Patterns which are strongly vertical or strongly horizontal do not work well.
Keep the final output in mind - if you are going to print the image on a black-and-white printer, dont use 
a pattern with lots of colors.

Rendering options
The ideal granularity, interval, and depth scaling depends on many factors, including the size of your 
image and the size of your monitor or printout.    The default values usually work well.    For low resolution 
monitors (640x480) you may want to decrease them.

As a general rule, the interval should be set so that the distance between the convergence dots is about 1
- 1.5 inches.    Depth scaling should typically be one-fourth to one-half of the interval value.

Printing hints
Printing stereograms on low resolution printers, including most dot-matrix printers, may cause distortions 
that will reduce the quality of the image.    Laser printers or high-resolution ink-jet printers are 
recommended for printing stereograms.

If you want to print the image on a black and white printer, such as a laser printer, you should choose the 
colors carefully.    Black and white are safe, plus one or two shades of gray depending on your printer.    
Experiment, but keep in mind that colors will be dithered when you print them, possibly making the 
stereogram difficult to see. 

If you are printing on a color printer, try to use colors that are not dithered.    The basic solids: black, white,
yellow, cyan, magenta, green, red, and blue will work well.



Viewing Stereograms

Learning to see these images can take some practice.    If you don't get them at first, don't be 
discouraged.    Some people take 30 minutes or more before they see the first one.    With a little practice 
it usually becomes much easier to see them.

If you have tried to see a stereogram that you rendered and can't, you may want to try changing the 
rendering options.    If the granularity, interval, or depth scaling are too large or small, the image may be 
difficult or impossible to see.    The default values will usually work well, but depending on the size and 
resolution of your monitor, you may need to change them to obtain good results.

The viewing environment can be very important.    For new viewers, it should be relaxed and quiet with 
good lighting (if viewing images on paper).    You need to be able to relax and concentrate for a while 
without disruptions.

First Method
Position the image a comfortable distance away from you - usually 18 to 24 inches.    Allow your eyes to 
relax and "space out" or wander away from a fixed focal point.    When you see the repetitions in the 
pattern, try to "lock in" on them so that they overlap.    You should begin to see the 3-D image emerge.    
Don't force it too hard, but slowly try to bring it into focus.    When you have it, you should be able to look 
around at other parts of the picture.

Second Method
If you have "convergence dots" on the picture, look at them and allow your eyes to relax and cross slightly
until you see three dots.    Look at the center dot and wait until your eyes have focused comfortably on it.   
Slowly lower your view to the rest of the image, and you should see the 3-D picture.
See Convergence dots .

Third Method
Position the image so that it is touching your nose.    You won't be able to focus on it, but that's OK.    
Relax your eyes so that you see a blurry mess of colors, and wait a few seconds until if feels comfortable. 
Now, slowly move the image away from your face.    Don't try to look at the image or focus on it, just relax 
and slowly move it away.    Soon, you should start to see depth in it.    Let the image develop, but don't 
force it.    Be patient, and soon the 3-D picture will become clear.    If you lose it at any time, just start over. 
Be sure to keep the image flat and level at all times.



Pattern Colors Dialog Box

You can select 2 to 16 colors to be used in generating a stereogram.    Samples of the selected colors are 
displayed in the boxes.    

To add a color, double-click on a box with an X through it and select the color from the color palette.
To change a color, double click on the color box and select the new color from the color palette.
To remove a color from the list, select the color by clicking on the color box and press the "Clear" 
button.

Hint: depending on your display, some colors may appear "dithered", or composed as dots of two other 
colors.    Other colors will be "solid."    Solid colors work best for viewing stereograms; dithered colors 
should generally be avoided.



Resizing the Image Window

The image window can be resized only when it contains source (original) images.    Resizing stereograms 
once they have been generated is not a good idea because it can distort the shifting of different parts of 
the image which produces the 3-D effect.    If you want a stereogram of a particular size, resize the image 
before rendering it.

To resize an image, position the cursor on the window border so that it turns into an arrow shape.    Then 
click and drag the border to a new position.    Note: resizing a bitmap image many times or stretching a 
very small image to a large one can cause distortions or reduced resolution.



Printing Images

To print an image, select Print from the File menu.    Stereolusions will print to the default printer as 
chosen in Print Manager.

Scaling
Determines the percentage by which the printout will be scaled.    Since printers usually have higher 
resolution (smaller pixels) than monitors, a 100% scaling will produce a smaller printout than the image on
your screen.

Fit to page
If you select this, the image will be scaled to the largest size that will fit on your page without distorting it.

Setup
Use this to change the orientation (Portrait/Landscape) of your printouts, or other printer-specific options.  
Landscape is often preferable for stereograms because you can make them larger than you could in 
portrait mode without distortion.
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